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Abstract:-It is desired to have a light weight, high strength and 

easy handling of LPG cylinder which economically satisfies the 

customer requirements. The study aims at reduction of weight 

of LPG cylinder. The commonly used material for the 

manufacturing of LPG cylinder is steel, but it is heavier and 

have safety issues. To find latest technologies, materials and 

techniques used in design and fabrication of LPG cylinder in 

industry for improving the existing LPG cylinder. To design 

and develop a light weight, high strength LPG Cylinder which 

is cheaper in cost as compared to the existing one. The finite 

element analysis of LPG cylinder using various materials viz. 

Steel, Aluminium alloy, Mg alloy has been carried out. At first 

the modelling is done in CATIA V5 R20 and then imported to 

ANSYS 16.0. The analysis has been done in ANSYS 16.0 and 

compared to classical mathematical formulations. Calculations 

are performed to determine the weight of the cylinder and the 

least weight material is chosen for the new LPG cylinder. 

Finally comparison between these materials is carried out 

stresses and deformations level maximum and minimum then 

we have find out, Aluminium is the best material than other 

materials because of its light weight. 

Keywords: Aluminium Alloy, Magnesium Alloy, Finite Element 

Analysis, Stress, Cylinder, Deformation. 

I. INTRODUCTION 

1.1 Introduction of LPG Cylinder :- Liquefied petroleum 

gas or liquid petroleum gas, also referred to as simply 

propane or butane, are flammable mixtures of hydrocarbon 

gases used as fuel in heating appliances, cooking 

equipment and vehicles.LPG is mixture of hydrocarbon 

gases, the most common being butane and propane. At 

room temperature, LPG is colorless and odourless non 

poisonous gas. For safety reasons, only 80% liquid is filled 

in LPG remaining 20% contains gaseous LPG. Anormal 

LPG cooking system is made of a steel cylinder filled with 

LPG, a pressure controller, a tube connecting the cylinder 

to the pressure controller and the burner and finally the 

burner itself. LPG is heavier than air, e.g. propane is one 

and a half times heavier than air and can therefore 

accumulate above the ground. 

1.2 LPG Market Production, Supply and Consumption: 

-  LPG is separated from raw oil and gas during extraction 

or refining. In order to stabilize the raw oil or gas, the 

accompanying products are extracted during a cleaning 

process. The accompanying gases are then either processed 

or burnt on the spot. The latter process is also known as 

flaring and approximately 140 billion m³ of potential LPG 

are burnt every year. Through further processing of the 

accompanying gasses, propane and butane are gained, 

which are used as LPG.A sophisticated infrastructure for 

the distribution of LPG is shown in figure 1.1. It can then 

be sold to distributors in its pressurized form. 

1.3 LPG as a by-product of the oil and gas industry is 

directly dependent on the extraction of fossil fuels. While 

larger production capacities may open up from the 

development of new fossil fuel sources, it has to be 

highlighted that most conventional fossil fuel fields are 

already being exploited. 

 

Figure 1.1 

1.3 Features of LPG :-  LPG is a low carbon fuel, it is 

used in thousands of industrial and commercial 

applications. LPG is cleaner than any other fossil fuel, 

highly energy-efficient and safe to use. In addition to these 

factors, LPG available and supports the use of renewable 

technologies. The Advantages of using LPG as an energy 

source are 

1. Increased fuel savings. 

2. High rate of heating – as high as 400 °C per hour  

3. Better heat transfer with LPG firing. 

4. No wastage of fuel due to spillage. 

5. Uniformity and increased end-product quality 

1.4 Applications of LPG cylinder 

1.4.1 Cooking :- A mixture of air and LPG can be ignited 

if the amount of LPG in air is between 2%-10%. The 

ignition temperature is above 380°C. The maximum flame 

temperature for LPG is around 2,000°C. The affordability 

of LPG is still a substantial barrier for many households 

that want to use LPG. Evidence shows that subsidies have 



INTERNATIONAL JOURNAL OF INNOVATIVE TRENDS IN ENGINEERING (IJITE)                                   ISSN: 2395-2946  

ISSUE: 96, VOLUME 72, NUMBER 01, DECEMBER 2020   

 

           7 

benefitted wealthier urban users more than low-income 

users as the former are in a better position to afford the 

high initial costs, e.g. to purchase the cylinder and the LPG 

burner. In most countries, access to LPG is limited to 

urban areas and LPG supply shortages are a frequent 

occurrence in rural areas. 

1.4.2 Rural Heating  :- LPG used as a power source for 

combined heat and power technologies (CHP). CHP is the 

process of generating electrical power and useful heat from 

a single fuel source. 

1.4.3 Motor Fuel :- LPG is used to fuel internal 

combustion engines, it is often referred to as autogas or 

autopropane. It has been used since 1940s as a petrol 

alternative for spark ignition engines.Autogas is the 

common name for liquefied petroleum gas (LPG) when it 

is used asa fuel in internal combustion engines in vehicles 

as well as in stationery applications. 

1.4.4 Refrigerator :- LPG is instrumental in providing 

off-the-grid refrigeration, usually by means of a 

gasabsorption refrigerator. Blended of pure, dry propane 

(refrigerant designator R-290)and isobutane (R-600a) the 

blend "R-290a" has negligible ozone depletion potential 

and verylow global warming potential and can serve as a 

functional replacement for R-12, R-22, R-134 and other 

chlorofluorocarbon or hydro fluorocarbon refrigerants in 

conventional stationeryrefrigeration and air conditioning 

systems [9]. 

II. LITERATURE REVIEW 

2.1 Somaiah et al. [2016] - The study of this paper is to 

elaborate on the design procedure of alternative materials 

for the manufacturing of liquid petroleum gas (LPG) 

cylinder. LPG is a colorless liquid that readily evaporates 

into a gas. A mixer of air, the gas can burn or explode 

when it meets a source of ignition. Composite materials 

are macroscopic combinations of two or more distinct 

materials having a discrete and recognizable interface 

separating them. Composites are heterogeneous materials. 

The weight savings are also presented for steel, Glass 

Fiber Reinforced Plastic (GFRP) composites LPG. LPG 

cylinder is reduced by cylinders replacing conventional 

metal by GFRP material [1]. 

2.2Amruta Muralidhar Kulkarni et al. [2015] - Finite 

Element Analysis is carried out using ANSYS commercial 

code. Burst Pressure (B.P.) is determined by applying 

Twice Elastic Slope Criteria (TESCA) of plastic collapse. 

Then the Mean Error (ME) is calculated between the 

experimental results and the results obtained by Finite 

Element Analysis (FEA). The FEA results showed a good 

agreement with experimental results [2].  

2.3 Remya Gopi et al. [2015] – Liquefied Petroleum Gas 

(LPG) is increasingly becoming the 

preferred choice of fuel in the world. The increase in 

patronage could be attributed to its affordability, efficiency 

and environmental friendliness. It has become necessary to 

design and execute the best customer oriented practices 

and to internalize them for providing enhanced satisfaction 

to the customer through the employees. LP-gas inside a 

container is in two states of matter, liquid and vapor. The 

liquid portion of container is in the bottom and the vapour 

is in the uppermost part of the vessel. Liquefied Petroleum 

(LP) Gas is stored and handled as a liquid when under 

pressure inside a LP-Gas container. 

2.4 Alok Tom et al. [2014] - Finite element analysis of 

cylinder subjected to internal pressure is 

performed. The analysis done in ANSYS is compared with 

classical mathematical formulations. 

Calculations are performed to determine the weight of the 

cylinders and the least weighed material is chosen for the 

new LPG cylinder. The cost estimation is also performed 

to check the economic viability of the new LPG cylinder 

[4]. 

2.5 T.Ashok et al. [2013] - The study of this paper weight 

of LPG cylinder can be saved enormously by using FRP 

composites and the stress values are also well within the 

limit of capability of materials. This gives a clear 

justification for its use in household applications. Weight 

of the steel cylinder = 13.31 kg (without end frames) 

Weight of the GFRP cylinder = 3.02 kg (without end 

frames) and Weight saving = 10.29 kg [5]. 

III. METHODOLOGY 

3.1 Research Methodology :- The following are the steps 

followed as the methodology adopted for the present work. 

(a) Study of different parameters of a gas cylinder. 

(b) Modeling of the gas cylinder. 

(c) Analysis 

3.2 Modeling of LPG Cylinder 

Various 3D models of LPG cylinder have been made with 

different height. CATIA is used for 

creating the model of LPG cylinder, which was thus 

imported to ANSYS software. 

 

Figure 3.1 LPG Cylinder 
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We have to consider 15.9 kg of LPG gas cylinder 

Table 3.1 

Empty gas cylinder weight 

with frame holder 15.9 Kg 

without frame holder 13 Kg 

Gas weight 14.2 Kg 

Volume of gas 47.8 L 

Perimeter 102 cm 

Diameter of cylinder 320 mm 

Length of cylinder 360 mm Internal pressure 

 

 

Figure 3.1 LPG Cylinder ANSYS View 

IV. SIMULATION AND RESULTS 

Simulation of improved LPG cylinder is done using 

ANSYS software. ANSYS 16.0 software has an easy-to-

use set of tools for 3-D mechanical design, documentation, 

and product simulation. 

Static analysis of LPG Cylinder using ANSYS 

Static structural analysis is done on LPG cylinder by using 

ANSYS 16.0. Static Analysis is 

done on the cylinder, as it is a member with is simply 

supported and other end is hinged. Static 

Structural analysis considers strain, stress, deflection and 

force caused due to external load 

acting on it and these loads do not induce significant 

damping effects. 

Assumptions 

For the study of cylinder in response to the load acting on 

it, some Assumptions have been 

made. In this analysis it is based on the assumption the 

point loads are acting over the 

Cylinder surface. Steady load and steady response. That is, 

the loads and the jaw plate response 

are assumed to be very slow with respect to time. 

Creating a New project in ANSYS software 

Firstly, we have to add the static structural template into 

the project, this is done by double 

Clicking on the toolbox 

Project > Static Structural > Engineering Data > Define 

Material Properties > Project 

Defining of Material Properties 

Add New Material in B4: Engineering Data, and name it 

Aluminum, now we are required 

To input actual Manganese Steel properties. For this, 

different properties value are Input in 

Properties of Outline row 3: 

Physical Properties 

Go to Physical Properties in Toolbox, then in dropdown 

menu, choose density, by right 

Clicking > include property. 

Linear Elastic Properties 

Isotropic elastic limit > include property 

Strength 

Include property > tensile yield > compression yield > 

tensile ultimate strength 

 

Fig.4.1 Adding the material properties 

Fig.4.2 Importing the CATIA model in .iges format to 

ANSYS 
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Importing model and Material assigning 

Geometry > import geometry > model 

Geometry > part-1> Material > Assignment > Aluminum 

Meshing 

Insert method > select the model to be meshed > Apply in 

Scope dropdown menu. 

Details of mesh: 

Size- Adaptive 

Relevant center –medium 

Element size –Default 

Mesh > Generate mesh 

FEA model is generated 

 

Fig.4.3 Inserting the method of meshing 

 

Fig.4.4 Selected body for meshing 

 

Fig.4.5 Mesh Model of LPG cylinder 

 

Fig.4.6 Fixed Support 

 

Fig.4.7 Pressure 

4.2.1 Cylinder thickness 2.5 mm 

4.2.1.1 von-Mises stress in LPG cylinder with thickness 

2.5 mm 

The figure 4.8 shows the range of the von Mises stress. 

The von Mises stress may be maximum 

up to 651.21MPa and minimum up to 0.67 MPa 

 

Fig.4.8 von Mises stress of Steel LPG cylinder (2.5mm) 

The figure 4.9 shows the range of the von Mises stress. 

The von Mises stress may be maximum 

up to 664.7 MPa and minimum up to 0.74 MPa 
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Fig.4.9 von Mises stress of Aluminum LPG cylinder 

(2.5mm) 

The figure 4.10 shows the range of the von Mises stress. 

The von Mises stress may be maximum up to 673.11 MPa 

and minimum up to 0.49 MPa 

 

Fig.4.10 von Mises stress of Magnesium LPG cylinder 

(2.5mm) 

4.2.1.2 Total Deformation in LPG cylinder with 

thickness 2.5 mm 

The figure 4.11 shows the range of the Total Deformation. 

The Total Deformation may be 

maximum up to 0.0024 m. 

 

Fig.4.11 Total Deformation of Steel LPG cylinder 

(2.5mm) 

The figure 4.12 shows the range of the Total Deformation. 

The Total Deformation may be 

maximum up to 0.0067 m. 

 

Fig.4.12 Total Deformation of Aluminum LPG cylinder 

(2.5mm) 

The figure 4.13 shows the range of the Total Deformation. 

The Total Deformation may be 

maximum up to 0.0104 m. 

 

Fig.4.13 Total Deformation of Magnesium LPG cylinder 

(2.5mm) 

4.2.1.3 Mass in LPG cylinder with thickness 2.5 mm 

The figure 4.14 shows mass in cylinder. Total mass is 

6.0164 kg and weight is 117.92 N 

 

Fig.4.14 Mass of Steel LPG cylinder (2.5mm) 

The figure 4.15 shows mass in cylinder. Total mass is 

2.123 kg and weight is 41.61 N. 
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Fig.4.15 Mass of Aluminum LPG cylinder (2.5mm) 

The figure 4.16 shows mass in cylinder. Total mass is 

1.379 kg and weight is 27.038 N 

 

Fig.4.16 Mass of Magnesium LPGcylinder(2.5mm) 

4.2.1.4 Maximum principal stress in LPG cylinder with 

thickness 2.5 mm 

The figure 4.17 shows the range of the Maximum Principle 

stress. The Maximum Principle 

stress may be maximum up to 651.1 MPa and minimum up 

to -35.11 MPa 

 

Fig.4.17 Maximum Principal Stress of Steel LPG cylinder 

(2.5mm) 

The figure 4.18 shows the range of the Maximum Principle 

stress. The Maximum Principle 

stress may be maximum up to 651.1 MPa and minimum up 

to -35.11 MPa 

 

Fig.4.18 Maximum principal stress of Aluminum LPG 

cylinder (2.5mm) 

The figure 4.19 shows the range of the Maximum Principle 

stress. The Maximum Principle 

stress may be maximum up to 672.2 MPa and minimum up 

to -46.66 MPa 

 

Fig.4.19 Maximum principal stress of Magnesium LPG 

cylinder (2.5mm) 

4.2.2 Cylinder thickness 3.1 mm 

4.2.2.1 von-Mises stress in LPG cylinder with thickness 

3.1 mm 

The figure 4.20 shows the range of the von Mises stress. 

The von Mises stress may be 

maximum up to 441.7 MPa and minimum up to 0.34 MPa 

 

Fig.4.20 von Mises stress of Steel LPG cylinder (3.1mm) 

The figure 4.21 shows the range of the von Mises stress. 

The von Mises stress may be 

maximum up to 450.9 MPa and minimum up to 0.38 MPa 
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Fig.4.21 von Mises stress of Aluminum LPG cylinder 

(3.1mm) 

The figure 4.22 shows the range of the von Mises stress. 

The von Mises stress may be 

maximum up to 459.52 MPa and minimum up to 0.59 MPa 

 

Fig.4.22 von Mises stress of Magnesium LPG cylinder 

(3.1mm) 

4.2.2.2 Total deformation in LPG cylinder with 

thickness 3.1 mm 

The figure 4.23 shows the range of the Total Deformation. 

The Total Deformation may be 

maximum up to 0.0014 m. 

 

Fig.4.23 Total Deformation of Steel LPG cylinder 

(3.1mm) 

The figure 4.24 shows the range of the Total Deformation. 

The Total Deformation may be 

maximum up to 0.0039 m. 

 

Fig.4.24 Total Deformation of Aluminum LPG cylinder 

(3.1mm) 

The figure 4.25 shows the range of the Total Deformation. 

The Total Deformation may be 

maximum up to 0.0061 m. 

 

Fig.4.25 Total Deformation of Magnesium LPG cylinder 

(3.1mm) 
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V. CONCLUSION AND FUTURE SCOPE 

5.1 Conclusion 

Based on the analysis of a LPG cylinder made of different 

materials following conclusions were drawn The new 

design model of a gas cylinder made of composite material 

viz. Aluminum Alloy of composition 5052H38 and 

thickness 4.5mm (slightly greater than existing one) 

exhibited greater strength (pressure induced by gas on  

cylinder walls) among all the chosen materials in the 

analysis . 

The new designed model is easy in transportation from 

Industry to homes. The new design help household wives 

to move the cylinders easily hence reducing human efforts. 

5.2 Future scope 

At present, the field of material science has excelled to 

provide the technology of high strength and low cost 

material to the manufacture. Thus design and optimization 

of these parameters for a gas cylinder may be done in 

future using variety of composite materials. 
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